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800 Text Field Properties
[ General Appearance Options Actions Format Validate Calculate |
Borders and Colors
Border Color: || Line Thickness: Thin
Fill Color: | Line Style: | Selid
Text
Font Size: | [1@ - Text Color: |l
Font: | Helvetica [ t]
[ Locked ( Close )

The Options tab while control how content behaves within the text field. This case, | want only a single
line of text, and no local formatting, so | have disabled all the options, but made sure that the text will
be centered on the line so that aligns with the form title above.

For this field's purposes, none of the other tabs — apply, so I'll ignore those here. Closing the Field
Properties dialog, my form now looks like this...
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a APPLICATION FOR EMPLOYMENT WITH "
] t e t
An Equal Opportunity Emp It to Company, under the Americans with
Disabilities Act will be provided as required by law.
L
Last Name First Name Middle Initial Sodial Security Mumber:
Street Address City/State Zip Code Phane Number:
It hired, €an you provide evidence of legal eligibdity to workin | Any g
the LS. and provid .
Yos: authrication, Whete appropriste snd perritted o sequieed by
: #1aae or federal law, 3 criminal ackground check andior dnag test
oz muay be requined prioe 10 emplayment
Position Deslred: Wage/Salary Desired: Full Time?
Part Tima?
Date you can bogin work? | Are you 18 years of age or older? "-L-_-dLﬂ By ol det, o el bt i 4
o federal Liw. T
- Name of high school attended: City & State Graduate? GED?
Nama of college or technical school: City & Stata Graduata? Degrea? Major:
¥
Are you presently enrclled in school? If yes, give name & address of school and expected degree date:
List any job-refated skills or accomplishments, including military service: P

Since | have created one Text Field, and | know | have many more, and
that they'll probably share many of the same formatting and behavior
attributes, I'll just the field I just created and paste as | need it for the
first two lines of content (which are all Text Fields). In these fields, |
changed the text alignment on the Appearance tab to Left.
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An Equal Opportunity Employer — If applicable to Company, reasonable accommodation under the Americans with
Disabilities Act will be provided as required by law.
L
It hired, can you provide evidence of legal eligibdity to workin | Any ]
tha US.7 sod
Yos: authrication, Whete appropriste snd perritted o sequieed by
: #1aae or federal law, 3 criminal ackground check andior dnag test
oz muay be requined prioe 10 emplayment
Position Deslred: Wage/Salary Desired: Full Time?
Part Time?
Date you can bogin work? | Are you 18 years of age or older? "-L-_-dLﬂ By ol det, o el bt i 4
o federal Liw. ) '
B Nama of high school attended: City & State Graduate? GED?
Name of collage o technical schook: City & State Gracuate? Degrea? Major:
¥
Are you presently enrclled in school? If yes, give name & address of school and expected degree date:
List any job-refated skills or accomplishments, including military service: P
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The Social Security Number, Zip Code, and Phone Number fields have specific formatting constructs
to ensure their data is input consistently and according to possible database needs. In the case of the
Social Security Number, | have clicked on the Format tab in the Field Properties dialog, selected
Special from the Select format category: list, and applied the Social Security Number format.

8,00 Text Field Properties
{ General Appearance Options Actions Format Validate Calculate !
Select format category: [ special [e]
Special Options

Zip Code

Zip Code + 4

Phone Number

Social Security Number

Arhitrary Mask v
Use the Special format category to set up custom formatting and to display
phone numbers, zip/postal codes, and social security numbers.

[ Locked ( Close )

Now we'll add a couple of radio buttons in the citizenship and full time/part time fields. The key trick
here is to ensure that all radio buttons that are to be mutually exclusive have the same field Name, but
that each of the buttons have a different Button Value. Therefore, the evidence of legal eligibility fields
I have named both LegalEligibility. The Yes button has a value of Yes, and the No button a value of No.

8,00 Radio Button Properties
[ General Appearance Options Actions |
Radio Button Properties Button Style: | Circle 3
General Appearance Options Actions | Bunton Value: | Yes
Name ibili
LegalEligibility [T Button is checked by default
Toohip [T Buttons with the same name and value are selected in unison
Common Properties To create a set of mutually exclusive radio buttens (i.e.,
. [ visibl = where only one can be selected at a time), give the fields the
DIniEled — — ] Read Only same name but different butten values.
Orientation: | 0 5| degrees # Required
[ Locked ( Close ) [ Locked ( Close )

In the position desired field, it is likely that you'll want to restrict the
application to selecting a single position, so in this space we'll place a

Combo Box.

Note the difference between
List Box and a Combo Box form
fields is that the user may make
multiple selections of the items
presented in the list, while a
Combo Box restricts the user to
making a single choice.
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800 Combo Box Properties

[ General Appearance Options Actions Format Validate Calculate |

Itern:  Photographer

Export Value:
Item List: Art Director _ Delete
Craphic Designer
Group Manager ~

Photographer
Production Artist

Iﬂ Sort items
E Allow user to enter custom text
Iﬂ Check spelling

] Commit selected value immediately

Select an itemn in the list to make it the default choice.

] Locked ( Close _\'

Within the field Properties dialog, you will populate the items con- Note which list item is selected
tained within the list on the Options tab by entering the information in in the field Properties dialog will
the Item value, then clicking on the Add button. If a value other than be the defaultitemin the form.
what you entered in the Item value is required when the form results

are exported, you can enter the value for the list item in the Export Value field. Otherwise the item
name will be used upon export. The Sort Items check box will force the list items into alphabetical (or
numeric) order. The Allow user to enter custom text will permit the user to type in their own value to
the form field.

The Wage/Salary Desired field is handled as a Text Field, but it must contain a number in terms of USD
currency. So, we need to handle its formatting as we did for the Social Security Number.

800 Text Field Properties

'General Appearance Options Actions Format Validate Caiculale'

Select format category: M

Number Options

Decimal Places: | 2 4
Separator Style: | 1 234.56 s
Currency Symbol: | pollar (5) +

Negative Number Style: [T Show parentheses

] Use red text

Example of current format: -5§4,123.03

Use the Number format category to display numbers, including currency styles.

[ Locked ( Close )
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We will continue along in this manner continuing to populate the form with the appropriate fields.
However, at this point | would like to discuss what the user does with the form data once it is completed.
So now we will add a button which will email the form to a user, a button to print the form, and in the
case where a user must start all over from scratch, a button to clear the form.

To begin, we'll select the Button tool, and place a button at the top-right, and one at the top-left cor-
ners of the document.

[mon o I Application (INDD) .pdf

Kk Il = @ 8 = on) =) bS] W e oot setecied B (e Preview ¢ Distibute Form ' | Clase Form Ediing

+/: °o [l

APPLICATION FOR EMPLOYMENT WITH

An Equal Opportunity Employer — If applicable to Company, reasonable accommodation under the Americans with
Disabilities Act will be provided as required by law.

¥
I hired, can you provide evidence of legal eligibdity to woek in
the US.T
Yeos: (@
Ne: @
Position Desired: Iulllumr\!g
JRl[Posmiontered JIEY Fart Time?
Date you can bogin work? | Are you 18 years of age or older? I ancles 18 ymary of age. you wil be tequined
T & birsh certificate or wark ceribicace as requ
e Federal L,
HName of high school attended: City & State Graduate? GEDY
Name of college or technical school: ity & State Graduate? Degree? Major:
Are you presently enrolled in school? If s, give name & address of school and expected degroe date:

The top-left button will be for the email function, so we'll double-click on that to open the Form Field
Properties dialog. I've given this button the name emailForm. On the Options tab, | have entred the
value e-mail Form in the Label field. This is the text that will on the button itself. You can also specify
a graphic here if you would like. The Layout list item specifies what kind of content you would like to
include on the button’s face. Our button will only include the label.

800 Button Properties

| General Appearance ‘Options Actions |

s

Layout: | Label only ™ Advanced

Behavior: | Invert 3:

Icon and Label

State:

Up Label [ e-mail Form

lcon: Choose Icon...

Clear

[ Locked Close
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On the Actions tab, | have selected the Mouse Up trigger and Submit
a Form from the Selection Action menu item. The Mouse Up trigger
means that when a user clicks on the button, the action indicated will

execute when the mouse is released.

[:NeNe) Button Properties
! General Appearance Options Actions

Add an Action

Select Trigger: [ Mouse Up a

Select Action: | Submit a form ]

( Add... )
Actions
U Dow Edit Delete
) Locked ( Close )
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Note the Select Action menu
contains a number of building
blocks you can assign to the
button to make programming
the button very simple. If you
are skilled in programming
Visual Basic, Ci# or similar
language, you can also program
these buttons with a number of
other executable actions.

For our form, we want the form data submitted to an email address, so now we'll click on the Add...
button, which calls up the Submit Form Selections dialog box. The Enter a URL for this link: field is
intended for a website link where you might send data as a text file where it is retrieved by a database.
However, since we want the form data emailed to us, we're going to enter a mailto: command.

Submit Form Selections

Enter a URL for this link:

[T Comments

] Incremental changes to the PDF
= Date Options
() HTML

() XFDF Include:

Dat bmitted i
O PDF The complete document ates are suamitted in

through unchanged.

Itazjim.kramer@jdkds.c ation for Employ
Export Format Field Selection
) FDF Include @) Al fields
v Field data O Only these.. Select fields...

[T Convert dates to standard format

D:YYYYMMDD format instead of
passing the user typed values

(_ Cancel ) OK

In the case of our form, we're sending the data results as an FDF (forms data format) file. Once the email
recipient receives the FDF file, they can import the file into their own copy of the PDF form, or parse the
information as a text-only file into a database. And since we're only interested in the form results, | have
told the export not to include any comments or, changes in the PDF. Also, while the results as an HTML
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page would be small to email, a database may not be able to parse the information. And XFDF is a spe-
cialized format that includes structure much like an XML file. And including the entire PDF file would be
unnecessarily large for emailing. So, sending the FDF files makes the most sense for this use.

The Print button we'll handle in a similar fashion, except on the Actions tab of the Form Field
Properties dialog, we'll select the Execute a menu Item option on Mouse Up.

Add an Action

Actions

v Mouse Up

[] Locked

800 Button Properties
| General Appearance Options Actions }
Select Trigger: | Mouse Up %
Select Action: | Execute a menu item )
( Add.. )
v Execute a menu item
File=Print...
U Down Edit [ Delete )

'r_ Close \

The Print button we'll handle in a similar fashion, except on the Actions tab of the Form Field
Properties dialog, we'll select the Reset a Form option on Mouse Up. This button I'll place at the bot-
tom of the page in the left corner.

Add an Action

Actions

v Mouse Up

] Locked

800 Button Properties
! General Appearance Options Actions
Select Trigger: [Mouse Up %
Select Action: | Reseta form H
( Add... )
Reset a form

!’_ Close \
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